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Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of semiconductor products and application examples. You are fully responsible for the incorporation of these
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for
any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever
for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other
intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade,
as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial
robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster
systems; anticrime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for
which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified
ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please
evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation,
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your
noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not
use Renesas Electronics products or technology described in this document for any purpose relating to military
applications or use by the military, including but not limited to the development of weapons of mass destruction. When
exporting the Renesas Electronics products or technology described in this document, you should comply with the
applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. Itis the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as
a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of
Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its
majority owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




General Precautions in the Handling of MPU/MCU Products

The following usage notes are applicable to all MPU/MCU products from Renesas. For detailed usage notes
on the products covered by this document, refer to the relevant sections of the document as well as any
technical updates that have been issued for the products.

1. Handling of Unused Pins

Handle unused pins in accordance with the directions given under Handling of Unused Pins in the

manual.

% The input pins of CMOS products are generally in the high-impedance state. In operation with an
unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an
associated shoot-through current flows internally, and malfunctions occur due to the false
recognition of the pin state as an input signal become possible. Unused pins should be handled as
described under Handling of Unused Pins in the manual.

2. Processing at Power-on

The state of the product is undefined at the moment when power is supplied.

%a The states of internal circuits in the LSI are indeterminate and the states of register settings and
pins are undefined at the moment when power is supplied.

In a finished product where the reset signal is applied to the external reset pin, the states of pins
are not guaranteed from the moment when power is supplied until the reset process is completed.
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function
are not guaranteed from the moment when power is supplied until the power reaches the level at
which resetting has been specified.

3. Prohibition of Access to Reserved Addresses

Access to reserved addresses is prohibited.

%, The reserved addresses are provided for the possible future expansion of functions. Do not access
these addresses; the correct operation of LSI is not guaranteed if they are accessed.

4. Clock Signals

After applying a reset, only release the reset line after the operating clock signal has become stable.

When switching the clock signal during program execution, wait until the target clock signal has

stabilized.

%2 When the clock signal is generated with an external resonator (or from an external oscillator)
during a reset, ensure that the reset line is only released after full stabilization of the clock signal.
Moreover, when switching to a clock signal produced with an external resonator (or by an external
oscillator) while program execution is in progress, wait until the target clock signal is stable.

5. Differences between Products

Before changing from one product to another, i.e. to a product with a different part number, confirm that

the change will not lead to problems.

%a The characteristics of an MPU or MCU in the same group but having a different part number may
differ in terms of the internal memory capacity, layout pattern, and other factors, which can affect
the ranges of electrical characteristics, such as characteristic values, operating margins, immunity
to noise, and amount of radiated noise. When changing to a product with a different part number,
implement a system-evaluation test for the given product.




Disclaimer

By using this Renesas Starter Kit+ (RSK+), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

ensure attached cables do not lie across the equipment

reorient the receiving antenna

increase the distance between the equipment and the receiver

connect the equipment into an outlet on a circuit different from that which the receiver is connected
power down the equipment when not in use

consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

The user is advised that mobile phones should not be used within 10m of the product when in use.
The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use the e’ studio IDE to develop
and debug software for the RSK platform. It is intended for users designing sample code on the RSK platform,
using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to load and debug a project in e” studio, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RZT1 microcontroller may be found in the Hardware Manual and within the provided sample
code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RZT1 Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
Quick Start Guide Provides simple instructions to setup the RSK+ and RSK+RZT1  Quick R20UT3244EG
run the first sample, on a single A4 sheet. Start Guide
User’s Manual Describes the technical details of the RSK+ RSK+RZT1 User’'s R20UT3242EG
hardware. Manual
Tutorial Provides a guide to setting up RSK+ environment, RSK+RZT1 Tutorial R20UT3243EG
running sample code and debugging programs. Manual
Schematics Full detail circuit schematics of the RSK+. RSK+RZT1 R20UT3241EG
Schematics
Hardware Manual Provides technical details of the RZT1 RZT1 Group RO1UHO0483EJ
microcontroller. Hardware Manual




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
e’ studio Renesas Eclipse Embedded Studio Integrated Debugging Environment
EMC Electromagnetic Compatibility
ESD Electrostatic Discharge
GDB GNU Debugger
J-LINK On-chip Debugger
LCD Liquid Crystal Display
LED Light Emitting Diode
MCU Micro-controller Unit
RSK Renesas Starter Kit
RSK+ Renesas Starter Kit + (denotes extra functionality over standard RSK)
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LENESNS

RSK+ RZTl R20UT3243EG0100
Rev. 1.00
RENESAS STARTER KIT Mar 21, 2015

1. Overview

11 Purpose

This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how to get the RSK+
tutorial started, and basic debugging operations.

1.2 Features

This RSK+ provides an evaluation of the following features:
Renesas microcontroller programming

User code debugging

User circuitry such as switches, LEDs and a potentiometer
Sample application

Sample peripheral device initialisation code

The RSK+ board contains all the circuitry required for microcontroller operation.

R20UT3243EG0100 Rev.1.00 Page 8 of 26
Mar 21, 2015 LENESAS



RSK+RZT1 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, the most common questions asked about using a Renesas
Starter Kit (RSK+). The tutorials help explain the following:

How do | compile, link, download and run a simple program on the RSK+?
How do | build an embedded application?
How do | use Renesas’ tools?

Files referred to in this manual are installed using the import wizard as you work through the tutorials. The
tutorial examples in this manual assume that installation procedures described in the RSK+ Quick Start Guide
have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to
the e? studio environment, compiler toolchains or the J-Link LITE debugger. Please refer to the relevant user manuals for
more in-depth information.

2.1 Note Regarding Source Code

Due to the project generator, it is possible that line numbers for source code illustrated in this document do not
match exactly with that in the actual source files. It is also possible that the source address of instructions
illustrated in this manual differ from those in user code compiled from the same source. These differences are
minor, and do not affect the functionality of the sample code nor the validity of this manual.

R20UT3243EG0100 Rev.1.00 Page 9 of 26
Mar 21, 2015 RENESAS




RSK+RZT1

3. Tutorial Project Workspace

3. Tutorial Project Workspace

3.1 Introduction

e’ studio is an integrated development tool that allows the user to write, compile, program and debug a
software project on the RZ family of Renesas microcontrollers. e’ studio will have been installed during the
installation of the software support for the Renesas Starter Kit product. This manual will describe the stages
required to create and debug the supplied tutorial code.

3.2 Jumper and Switch Configuration
Ensure jumpers and switches are in the NOR Boot Setting positions:

Jumper Pins NOR Boot Setting QSPI Boot Setting
Switch Position Switch Position

JP2 2-3 SW4-1 ON SW4-1 ON

JP7 1-2 SW4-2 OFF SW4-2 ON

-- -- SW4-3 ON SW4-3 ON

- - SW4-4 ON SW4-4 ON

-- -- SW4-5 ON SW4-5 ON

- - SW4-6 OFF SW4-6 OFF

3.3 Starting e studio and Importing Sample Code
Start Eclipse for e studio by selecting it from o

the Start Menu -> All Programs -> Renesas  Selecta workspace
Electronics e2 studio 3.1 -> Renesas €2

studio. The first dialog box to appear will be

e2 studio stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

the Workspace Launcher. Workspace: | = _gomse.. |
Click ‘Browse’ and select a suitable location

to store yOl’Jr W_0rk5pacea USing the' ‘C‘rea’te [~ Use this as the default and do not ask again

New Folder’ option as necessary. Click ‘OK’. — i

Note: The Workspace location does not have to contain your project files, the workspace contains the
configuration of the tool and can group projects together. Projects may be referred to from this location, or the
projects may be stored under this directory.

2 . . . o ] - e2 studio
e” studio will open with the ‘Welcome..." tab Doty
as shown opposite.

@ Welcome 32

Welcome
e2studio

=

Close the tab by clicking on the cross. ®

R20UT3243EG0100 Rev.1.00
Mar 21, 2015

) Page 10 of 26
RENESAS



RSK+RZT1

3. Tutorial Project Workspace

Right click in the ‘Project Explorer’ window
and select ‘Import...’

The Import dialog box will now show.
Expand the ‘General’ folder icon, and select
‘Existing Projects into Workspace’, then click
‘Next'.

File Edit Source Refactor MNawic

N R

E}, Project Explorer &3

=3

Mew 3
£2q Impart...
7 Export...

# | Refresh F5

Select

Create new projects from an archive file or directory.

Select an import source:

| type filter text

E= General

@; Archive File

""" e Convert CCRX to GNURX Project
""" T DS-5 KPIT GNUARM-RZ Project
----- '[§ Existing Projects into Workspace
{7, File System

----- iE HEW Project

""" El preferences

""" & Renesas Common Project File
= CfC++

(= Code Generator

B CVS

- Git

(2= IAR Embedded Workbench
(= Install

ml;t'; RunMehun

----- '[é Rename & Import Existing C/C++ Project into Workspace

|»

@ < Back I Mext = I Eirish

Cancel

R20UT3243EG0100 Rev.1.00

Mar 21, 2015 RENESAS
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RSK+RZT1

3. Tutorial Project Workspace

The Import dialog box will allow you to
specify a project to import. Click the ‘Browse’
button and locate the following directory:

C:\Renesas\Workspace\RSK\RSK+RZT1

Ensure that the ‘Copy projects into
workspace’ option is ticked.

Caution: Ticking this box will copy the
projects from the location where they were
installed. It is important to select this option
to preserve the projects that were installed
so that you can return to them in the future.

Click ‘Finish’.

Import Projects

=1olx|

X

Select a directory to search for existing Eclipse projects.

% Select root directory: IC:\,Renesas\\“a’orkspace\,RSK\RSK-\\RZT1 Browse. ..

=
" Select archive file: I j

Erowse,. .
Projects:

Application {C:\Renesas\Workspace \RSKIRSK+RZT 1Application)
Async_Serial {C:\Renesas\Workspace\RSK\RSK+HRZT 1\Async_Serial)
CG_Tutorial {C:\RenesasWorkspace \RSK\RSK+HRZT 1\CG_Tutorial)

W] System_Boot_Loader_MOR {C:\Renesas\Workspace \RSKI\RSK+RIT 1\Syst
System_Boot_Loader_QSPI (C:\Renesas\Workspace \RSK\RSK+RZT1\Syst
System_Input_Capture {C:\Renesas\Workspace \RSK\RSK+RZT 1\System_
Timer_PWM (C:\Renesas\Workspace\RSK\RSK+HRZT 1Timer_PWM)

Select All

Deselect Al

e L e

Refresh

Tutorial (C:\Renesas\Workspace \RSK\RSK+HRZT 1 Tutorial)
< | i
 Options
s

™ Hide proje at already exist in the workspace

~Working sets

[~ Add project to working sets

‘Working sets;

j Select.,, |

® < Back Talext = | Finizh I Cancel

R20UT3243EG0100 Rev.1.00
Mar 21, 2015
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RSK+RZT1 3. Tutorial Project Workspace

3.4 Build Configurations and Debug Sessions

34.1 Build Configuration
The e studio workspace will be created with two build configurations: ‘HardwareDebug’ and ‘Release’.

HardwareDebug

This default build mode has all optimisation turned off, and provides full debug information. This is the best
configuration to use whilst developing code as C code execution will be linear. The ‘HardwareDebug’ build
configuration provided for this Tutorial program is configured to load the code directly into RAM.

Click the top level ‘Tutorial’ folder again, ﬁ v = @ .:;;I ,fz? = 1

and then the arrow next to the build
button (hammer icon), and select the v

‘HardwareDebug’ option. ﬁ 1 HardwareDebug

2 Release
e? studio will now build the
code.

The output from the build process will be
presented in the console window of e’
studio.

3.4.2 Debug Configuration

Click the arrow next to the %% ~ #3 - & ~ (% (o
debug button (bug

icon). Select ‘Debug
Configurations’. Debug As r

rmo launch histary)

Debug Configurations. ..
Organize Favaorites...

The ‘Debug Configurations’ | = Hh. .
dialog box will appear. Click -

on the button next to | |type filter text

‘Renesas  GDB Hardware

Debugging’ to expand the o [E7| Debug-only

view. --[€ | GDB Hardware Debugaing

By default, e? studio creates ----- [c7| GDB Simulator Debugging (5H, RL73, RHE50)

Debug Configurations  for iy GHS Local C/C-++ Launch

each existing build mode. The &% Renesas GDB Hardware Attach
RSK+RZT1 project have pre- E Renesas GDB Hardware Debugging
configured debug “-[c7 Renesas Simulator Debugging (RX only)
configurations that are ready

to use.

Note:

To manually create a new e’
studio debug configuration,
click on ‘Renesas GDB
Hardware Debugging’ then

click on the ‘New’ button

R20UT3243EG0100 Rev.1.00 _ Page 13 of 26
Mar 21, 2015 RENESAS



RSK+RZT1

3. Tutorial Project Workspace

The debug configurations
control page will open.
Observe the settings under
each tab.

Under the ‘Debugger’ tab,
ensure the ‘Debugger

hardware’ option is set to ‘J-
Link ARM'.

The ‘Target Device’ is preset
to ‘R75910018".

Note:
Do not modify any settings.

A security dialog may appear
indicating that the Windows

Firewall has blocked some
features of the eclipse
platform.

Under the text ‘Allow eclipse
to communicate on these
networks’, ensure the check
box next to ‘Private networks,
such as my home or work
network’ is ticked. Click
‘Allow access’

Select the ‘Startup’ tab.

Ensure that ‘Halt’ is the only
tickbox selected.

Click on ‘Debug’.

£

Create, manage, and run configurations

&

CExXox- Wame: | Tutorial HardwareDebug
[Eme fiter toxt [5 Main . %5 Debugger | - Startup | (] Common| 1. Source |
[&7 Debug-only _
Broject:
[E] GDB Hardware Debugging i
~[E7] GDB Simulator Debugging (SH, RL7S, RHB50) [Tutorial Browse...
ik GHS Local CC++Launch c/c++ Application:

i£% Renesas GOB Hardware Attach

[E-[E7 Renesas GDB Hardware Debugging
P fTutorial IUIC

[ Tutorial Release

[ HardwareDebug/Tutorial.x

Variables... | SearchProject... | Bromse... |

Build (if required) before launching
[E7 Renesas Simulator Debugging (RX only)

Buld configuration: |HardwareDebug

 Enable auto build
{ Use workspace settings

" Disable auto buid
Confiqure Workspace Settings. .

Filter matched 9 of 13items

Fgply Reyert

@

B Windows Security Alert

@ Windows Firewall has blocked some features of this program

Windows Firewall has blocked some features of E2 Server GDE on all public and private
networks.

@ hame:
publisher:

Path: Ci\enesas\e2_studio\debugcomple2-server-gdb.exe

E2 Server GDB

Renesas Electronics Europe Ltd

Allow E2 Server GDB to communicate on these netwarks:
Private networks, such as my home or work network.

[FIBubic ntionks, such as hose in airports and caffee shops (ot recammended
ecause these networks often have litle or n seaurity),

What are the risks of allowing a program throuah a firewall?

Debug Configu

Create, manage, and run configurations

=R JCE-R
type filter text

[£] GDE Hardware Debugging
[€7 GDE Simulator Debugging (SH, RL78, RH8S0)
&% Renesas GDB Hardware Attach
4[] Renesas GDB Hardware Debugging
[ Tutorial HardwareDebug
[ Tutorial Release
[£7 Renesas Simulator Debugging (RX only)

Name: Tutorial HardwareDebug

[E) Main | %5 Debugger | B Startup
Initialization Commands
[] Reset and Delay (seconds): | 2
Halt

Load image and symbols

% Source| (] Common

Filename Load type

[] Program Binary [Tutori.. Image and Symbols

Offset (hex)

On connect
Yes

Add...

Edit...

Remove

I

Move up

Move down

Runtime Options

[] Set program counter at (hex):

[ Set breakpoint at: _main
[T Resume

Run Commands

-exec-interrupt

-data-write-memory-bytes --thread 1 0 "FF" 524288
-data-write-memory-bytes --thread 1 8396800 "FF" 22784
load applications/RAM_DEBUG_JUMP.x

Filter matched 7 of 11 items

@

[l

Apply Revert

Close

Debug I

R20UT3243EG0100 Rev.1.00
Mar 21, 2015
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RSK+RZT1 3. Tutorial Project Workspace

Before downloading the code @

a dialog box will appear (7 e
asking if you would like to e e e e e
switch to the ‘e’ studio Debug e

perspective’. If you agree click
‘Remember my decision’ to
prevent this dialog box from
appearing in future, then click

Do you want to open this perspective now?

I~ Remember my decision

‘Yes'.
e® studio will load the new
perspective, which is

optimised for debugging.

To change back to the default
‘C/IC++' perspective, from the
menu bar select Window >
Open Perspective > Other

The ‘Open Perpsective’ dialog
box will appear. Click on the
desired perspective to select
it then ‘OK’.

Alternatively, click on the
button within the top right
corner of the screen, as
shown opposite, and select
the ‘C/C++’ perspective.

=1 | Bgjc/c++ % Debug

3.4.3 Running the Tutorial

Once the code has been downloaded, the program counter will stop at the entry vector, the ‘start’
function.

Click the ‘Resume’ button to let the code run. It will keep running up to the ‘main’ function. Execute the

main code function. (e

It is recommended that you execute the entire tutorial demo first, before continuing to debug it. Please
refer to the ‘description.txt’ for details of how to operate this sample.

R20UT3243EG0100 Rev.1.00 _ Page 15 of 26
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RSK+RZT1 4. Reviewing the Tutorial Program

4. Reviewing the Tutorial Program

This section will look at each section of the tutorial code and basic debugging functionality in e’ studio.

4.1 Program Initialisation

Before the main program can run, the microcontroller must be configured. The following parts of the tutorial
program are used exclusively for initialising the microcontroller so that the main function can execute correctly.
The initialisation code is run every time the device is reset via the reset switch or from a power cycle.

Build and download the code as shown in
Section 3.4.

On the Project Explorer tab expand the o= Outline | [ Project Explorer 52

‘Tutorial’ folder by clicking on the arrow

next to the folder icon, as highlighted by _

the red circle. E? System_Input_Capture
- Timer_Pyim

@ Tutorial [HardwareDebug]

Click the arrow next to the ‘src’ folder to ---Iﬂ r_co_scifa_user.c
show the source files. & [ r_co_scifa.c
Expand the ‘cg_src’ folder in the same r_cg_sdfa.h
way and double click on SR o systeminit.c

‘r_cg_systeminit.c’ to open the file. &€ r_co_tpu_user.c

@ r_cg_tpu.c
&[] r_cg_tpu.h

@ * Function Name: E_Sys;:eminItD
vold R_Systeminit(wvoid)

1

Breakpoints can be set by double clicking
at the left-hand edge of the source
window. On the line with instruction DI(),
double click next to the vertical line to set
a breakpoint.

63
-
70

DI():

Note: As an alternative breakpoints may be
set in the C/C++ perspective by selecting a

i H . E*E F +3 I _ o
line and using Run > Toggle Breakpoint. * unction Name: SEESSSSNRRE |

vold R_Systeminit(void)
1
DI();

Click the ‘Resume’ button in the Debug
perspective (or press [F8]) to run the
code up to this breakpoint.

L

Note: The program counter is indicated by the
blue arrow next to the breakpoint.
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= void R_Systeminit(guidj

{

Click the ‘Step Over’ button (or press
[F5]), to step over the ‘DI

function. [y DI();

o . * Enable writing to register
The ‘R_Systeminit’ function _ SYSTEM.PRCR. LONG = @x0@@0ASEB
calls several initialisation functions which
configure the microcontroller for normal
operation. For example this includes

input/output ports, and system clocks.

/* Enable writing to MPC pin
MPC.PWPR.EBIT.BEWI = @U;
MPC.PWPR.BIT.PFSWE = 1U;

0O

r_set exception_handler();

=]

The user can step through all the
initialisation code by clicking the ‘Step
Into’ icon and reading the code however
for the purpose of this manual, it will be
skipped.

/* Set peripheral settings */
R_CGC_Create();
R_ICU Create();
R_PORT Create();
)s
()

[EEI S R ]

R_TPU Create(
R_CMT4 Create();
R_CMTS Create();
R_SCIFA2 Create();
R_RSPI1 Create();
R_512AD8 Create();
R_MPC_Create();

=]

Click the ‘Resume’
button, to run the code up UF"
to the main function.

L e T T T O O O O
woca 1% Y

]

[Ta]

For further details regarding hardware configuration, please refer to the RSK+RZT1 User’'s Manual and the
RZT1 Group Hardware Manual.
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4.2 Main Functions

This section will look at the program code called from with the main() function, and how it works. It is
necessary to connect the RSK+'s+RL78G1C-USB connection to a PC USB port and open a terminal
emulation program, such as HyperTerminal, with the settings 19200, 8, N, 1. For information on installation of
the RSK++ virtual COM port driver, refer to the file ‘description.txt’ in the e” studio Tutorial project.

Open the ‘r_cg _main.c'. 95 = void main(void) - Source Alt+hift+5 ’
: s, { Refactor 3
Right . click the R Systeminit(); _
‘g_switch_press flg = O 98 Dedarations r
instruction call and select 29 R_MAIN UserInit(); RE"E;:”"ES ’
. . , 2e Search Text 2
Run to Line’ to execute the o1 ¢ Start user code. Do nof
program up to this line. The 82 Make Targets ¢
PmodTMLCD WI” dlsplay text 83 display_off(); Resource Configurations 3
d - £ th a4 clear_display{COL_WHITE); Euild Selecked File(s) i g [
gn anl mage o € a5 S?SPiaY—imz%g (E“?”::_t *. Clean Selected File(s) ctrl4
enesas 10go. isplay_lc s (uintd t o )
9 display lecd(2, (uintd t ot Step Into Selection T
display_led(4, (uints_t cc|EIHNG_Gg_— I
display_on(); .
3. Move To Line
* Clear flags */ L, Resume At Line
g_switch_press_flg = B,'| %Y Add Watch Expression. ..

Set a breakpoint on the
‘R_SCIFA2_Serial_Send’
function call by double-
clicking in the breakpoint
column.

/* Display the welcome banner on the serial terminal */
R_SCIFA2 Serial Send((uintZ_t *)&welcome_banner, sizeof(welcome_banner));

Click the ‘Step Into’ button to =il
step into the i
‘R_SCIFA2_Serial_Send’

function.

MD_STATUS R_SCIFA2 Serial Send(const uint8_t * tx buf, uintl6_t tx_num)

The program counter will 4 ;

now move into the
‘R_SCIFA2_Serial_Send’
function  definition.  This

MD_STATUS status = MD_OK;

if (tx_num < 1U)

9
function is an API function 8 { status = MD_ARGERROR;
provided by the Code 1 }
Generator. It sets up the : zlse

SCl interrupt handler code to
transmit a specified number
of bytes to the serial port.

For full details on how to
configure a project using

gp_scifa2_tx address = tx_buf;
g_scifa2_tx_count = tx_num;
SCIFA2.5CR.BIT.TE = 1U;
SCIFAZ.5CR.BIT.TIE = 1U;

}

return (status);

Code Generator refer to the }
Code Generator Tutorial
Manual.
Click the ‘Step Return’ '
button to execute all the i 1
instructions within the
‘R_SCIFA2_Serial_Send’
function and exit the
function.
R20UT3243EG0100 Rev.1.00 Page 18 of 26

Mar 21, 2015 RENESAS



RSK+RZT1 4. Reviewing the Tutorial Program

The program counter should come to a ‘Ehile (1u)

halt at the [ if ((g_terminal_request) ” /* Check for a walid request from the switch or serial terminal */
(g switch press f|g & if ((g_terminal_request) || (g_switch_press flg & SW3 PRESS FLG))
SW3_PRESS_FLG)) instruction inside /* Initiate an A/D conversion */

the main while loop. This conditional R_S12AD8_Start();

statement checks for a SCI or SW3 o . _ .

. /* Wait for completion of A/D conversion */

Input. while (1U == S12ADC@.ADCSR.BIT.ADST)

{
nep();

* Read the conversion result */
R_512AD8_Get_ValueResult(7, (uintle_t *) &adc_result);

/* Read the conversion result */
R_512AD@_Get_ValueResult(7, (uintls_t *) &adc_result);

Set a breakpoint on the
‘R_S12AD0_Get_ValueResult’ function
call by double-clicking in the breakpoint
column.

Click the ‘Resume’ button, to run the
code.

In the terminal emulation window, press
the ‘c’ button on the keyboard.

Code execution will halt at the last
breakpoint.

Step over the instruction
by clicking the ‘Step Over’ o,

button. Alternatively, press =
[F6].
The ‘R_S12AD0_Get ValueResult’

function reads the result of the A/D
conversion of ADC channel input 7 and
stores it into the ‘adc_result’ buffer.

Remove the breakpoint by double-
clicking on the breakpoint column.
Continue to execute the program by
clicking the ‘Resume’ button.

The program proceeds to display the
result of the A/D conversion on the LCD
and in the terminal window. In addition,
the running count of A/D conversions
performed is displayed in binary form
using LED2 and LED3 on the RSK+.

In the Project Explorer pane, locate the
file ‘r_cg_icu_user.c’ and double-click to
open the source file. Scroll down to the
function ‘r_icu_irql2_interrupt'.

void r_icu_irgl2 interrupt(void)

1

VIC.PICE.LONG = exesalesaaUl;
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Set a breakpoint on the line of code
inside the r_icu_irq12_interrupt function
as shown opposite.

Continue to execute the program by
clicking the ‘Resume’ button.

Press switch SW3 on the RSK+.

The program will halt at the breakpoint
in the r_icu_irql2_interrupt function as
shown opposite. Remove the breakpoint
by double-clicking on the breakpoint
column.

Continue to execute the program by
clicking the ‘Resume’ button.

The program proceeds to update the
result of the A/D conversion on the
Pmod™ LCD and in the terminal
window. In addition, the running count
of A/D conversions is also updated and
displayed in binary form using LED2
and LED3 on the RSK+.

The program will continue to run until
normally.

void r_icu_irql2 interrupt(void)

VIC.PICR.LONG = exeseleaaall ;
'* Start user code. Do not edit comment generated here */

'* et global switch flag to indicate SW3 is pressed */
g switch_press flg |= SW3_PRESS_FLG;

/* End user code. Do not edit comment generated here */
VIC.HVAR.LONG = @x@eaepaaaUl;

'* Set global switch flag to indicate SW3 is pressed */
g switch_press_flg |= SW3_PRESS_FLG;

The program proceeds to display the result of the A/D conversion on the Pmod™ LCD and in the terminal
window. In addition, the running count of A/D conversions performed is displayed in binary form using LED2
and LED3 on the RSK+. Adjust the potentiometer (RV1) and press SW3 on the RSK+ and an additional A/D

conversion will be performed.

Press the ‘Suspend’ button to halt
program execution.

To change back to the default
‘C/C++’ perspective, from the menu
bar select Window > Open
Perspective > ‘C/C++’

Alternatively, click on the ‘C/C++
button in the top right corner of the
screen, as shown opposite.

This is the extent of the tutorial code.

Uy

w5 || B crc++

%5 Debug

For further details regarding hardware configuration, please refer to the RSK+RZT1 User’s Manual and the RZT1

Group Hardware Manual.
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5. Troubleshoot

5.1 Debugging in RAM (TCM)

The RZ/T1 expects the user to preload the loader parameters and a boot loader application into the NOR (U3)
and QSPI flash devices for correct operation of the device. Failure to do this will result in problems during
debug user applications in the ATCM and BTCM.

RSK+RZT1 boards are programmed with a boot loader binary into the QSPI and NOR flash devices during
production. These binaries, include the boot loader parameters required by the RZ/T1’s boot loader program
during boot. Should the user erase the QSPI or NOR flash, reprogramming of the boot loader binary is
required to ensure debugging from RAM will not be affected. To program the boot loader to the relevant flash
device:

1. Locate the System_Boot_Loader_NOR or System_Boot_Loader_QSPI sample project from
C:\Renesas\Workspace\RSK\RSK+RZT1.

Build the Release build configuration.

Ensure to configure switch bank SW4 according to the boot mode. See Section 3.2.

Connect the Segger J-Link debugger and 5V power supply.

Run the Program_QSPI_Loader.bat or Program_NOR_Loader.bat batch file from the sample project’s
root folder.

6. Select Option 3 to only program the boot loader binary.

arwN

An alternative method to program the QSPI boot loader is to build and run the Release build of one of the
following samples:

Application
Async_Serial

System Input Capture
Timer PWM

Tutorial
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6. Additional Information

Technical Support
For details on how to use e” studio, refer to Help
the help file by opening e® studio, then
selecting Help > Help Contents from the
menu bar.

SE
iz Welcome

(?) Help Contents
‘" Search
Dynamic Help

For information about the RZT1 series microcontrollers refer to the RZT1 Group Hardware Manual.
Technical Contact Details
Please refer to the contact details listed in section 11 of the “Quick Start Guide”

General information on Renesas microcontrollers can be found on the Renesas website at:
http://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe Limited.

© 2015 Renesas Electronics Europe Limited. All rights reserved.
© 2015 Renesas Electronics Corporation. All rights reserved.
© 2015 Renesas Solutions Corp. All rights reserved.
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